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Paper Set 1 · 31 May 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
The height of a triangle is equal to the side of a square whose
perimeter is 24 cm. The base of the triangle is 9 cm more than its
height. What is the area of the triangle?

A.  18 cm2

B.  27 cm2

C.  36 cm2

D.  45 cm2

✓

Q2 Quant
Find the smallest 3-digit number which when divided by 8, 10, 12,
and 16, leaves a remainder of 2 in each case.

A.  122

B.  222

C.  242

D.  102

✓

Q3 Quant

Two numbers are in the ratio 5 : 6, and another pair of numbers is in
the ratio 10 : 13. If the difference between these two ratios is written
in the form A : B, then what is the sum of the digits of (A + B + 2AB)?

A.  13

B.  15

C.  17

D.  19

✓

Q4 Quant
Rohit and Karan start from two towns 240 km apart and move
towards each other. Rohit starts from Town A at 7:00 a.m. with a
speed of 40 km/hr. Karan starts from Town B at 9:00 a.m. with a
speed of 60 km/hr. At what time will they meet?

A.  10:36 a.m.

B.  10:30 a.m.

C.  11:00 a.m.

D.  10:50 a.m.

✓

Q5 Quant
The cost price of article A is ₹400 more than the cost price of article
B. Article A is sold at a loss of 20%, while article B is sold at a profit of
50%. On the whole, the dealer makes a profit of 10%. What is the
selling price (in ₹) of article A?

A.  1,280

B.  1,300

C.  1,310

D.  1,350

✓

Q6 Quant

If p = 7 and q = - 5, what is the value of (p + q)2 - 2pq?

A.  84

B.  74

C.  66

D.  78

✓

Q7 Quant
The median of given set of numbers 31, 38, 17, 21, 23, 15, 13, 19, 25
is X. If 31 is replaced by 14, then new median is Y. Find the sum of X
and Y.

A.  38

B.  40

C.  41

D.  44

✓

Q8 Quant
A and B start a business with a capital of ₹15,000 and ₹25,000,
respectively. If the total profit is ₹8,000, what is A's share?

A.  ₹2,800

B.  ₹3,100

C.  ₹3,000

D.  ₹2,900
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✓

Q9 Quant
If 20% of a number is added to 24, then the result is the same
number. 75% of the same number is:313

A.  22.5

B.  7.5

C.  52.5

D.  42.5

✓

Q10 Quant
A sum of ₹2,898 is divided into three parts such that half of the first
part, one-fourth of the second part, and one-eighth of the third part
are equal. What is the positive difference (in ₹) between the first and
the second parts?

A.  414

B.  314

C.  464

D.  514

✓

Q11 Quant
Akshay has ₹1300 with him. He divided it between his sons Arjun
and Kartik and asked them to invest it at 8% rate of interest
compounded annually. It was seen that Arjun and Kartik got the
same amount after 14 and 15 years, respectively. How much money
(in ₹) did Akshay give to Kartik?10085

A.  625

B.  675

C.  475

D.  775

✓

Q12 Quant
PS is a tangent line to the circle with centre C and PQR is the secant
line. If PQ = 8 cm and QR = 10 cm, then find PS.

A.  8 cm

B.  12 cm

C.  18 cm

D.  9 cm

✓

Q13 Quant
What is the radius of a circular disc whose circumference is 308 cm?
(Use π = 22/7)
1343

A.  7 cm

B.  49 cm

C.  22 cm

D.  11 cm

✓

Q14 Quant
In what time (in months) will ₹3200 fetch an interest of ₹480 at 5%
per year simple interest?

A.  36

B.  33

C.  34

D.  40

✓

Q15 Quant
A number when increased by 60%, gives 3440. The number is:

A.  2150

B.  2300

C.  1075

D.  1450

✓

Q16 Quant
P and Q together can completely fill an empty cistern with water in 6
hours. If P alone can fill the same amount of water in 9 hours, in
how many hours will Q alone fill the same amount of water?

A.  18

B.  19

C.  20

D.  17

✓

Q17 Quant
A trader gains 20% by selling an article after two successive
discounts of 54% and 40% on its marked price. If the cost price of
the article is increased by 25%, then what single discount should he
now give on the same marked price to get the same profit
percentage as earlier?

A.  65.5%

B.  56.8%

C.  53.7%

D.  64.9%
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✓

Q18 Quant

A.  8 hours

B.  10 hours

C.  12 hours

D.  18 hours

✓

Q19 Quant

A.  

B.  

C.  

D.  

✓

Q20 Quant
Simplify: 81 - { (-7) × (-5 - 8 - 11) } ÷ [1 × (7 + (-5) × (-4))]

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Who took charge as the 26th Chief Election Commissioner of India
on February 19, 2025?

A.  Shri Anup Chandra Pandey

B.  Shri Arun Goel

C.  Shri Rajiv Kumar

D.  Shri Gyanesh Kumar

✓

Q22 GA
Which is the second highest peak of Odisha, located in Gajapati
district?

A.  Chandragiri

B.  Taptapani

C.  Mahendragiri

D.  Karlapat

✓

Q23 GA
Which of the following is a classic example of relict mountains in
India?

A.  Himalayas

B.  Aravalli Range

C.  Western Ghats

D.  Eastern Ghats

✓

Q24 GA
Which of the following initiatives launched by the Government of
Odisha in May 2025 aims at facilitating access to government
welfare schemes for the urban poor?

A.  Nagar Bandhu

B.  Sahajog

C.  Nagar Mitra

D.  Suvidha Sampark

✓

Q25 GA
Which ion is responsible for the acidic properties of acids in an
aqueous solution?

A.  Cl⁻ ion

B.  H⁺ ion

C.  SO₄²⁻ ion

D.  OH⁻ ion

✓

Q26 GA
Which country became the 107th member of the International Solar
Alliance (ISA) in 2025?

A.  Moldova

B.  Ukraine

C.  Greece

D.  Albania

✓

Q27 GA
Which of the following combination of factors most favors insect
infestation during storage?

A.  High moisture, warm temperature, and poor ventilation

B.  Dry grains, cool temperature, proper ventilation

C.  Low temperature, dry grains, sealed containers

D.  Clean and ventilated storage

✓

Q28 GA
The distinction of being Odisha’s first woman Chief Minister belongs
to which political leader?

A.  Nandini Satpathy

B.  Malti Choudhory

C.  Pramila Mallik

D.  Aparajita Sarangi

✓

Q29 GA
Which of the following is a key change introduced by the
Transgender Persons (Protection of Rights) Amendment Act, 2026?

A.  Introduction of universal basic income for transgender
persons

B.  Replacement of self-identification with medical board
certification

C.  Reservation of seats in Parliament for transgender persons

D.  Complete decriminalisation of all gender identity disputes

✓

Q30 GA
Under the Odisha Homestay Establishment Scheme, 2025, what is
the ceiling considered for homestays outside notified Gram
Panchayats that are eligible only for non-financial incentives?

A.  4 rooms and 8 beds

B.  5 rooms and 10 beds

C.  6 rooms and 12 beds

D.  8 rooms and 16 beds
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✓

Q31 GA
Which of the following best explains why the Northern Plains are
highly fertile in India?

A.  Presence of volcanic rocks

B.  Deposition of alluvial soil by rivers

C.  High mineral content in desert sand

D.  Frequent earthquakes enriching the soil

✓

Q32 GA
Which right protects the interests of minorities regarding their
language, script, or culture?

A.  Right to Freedom

B.  Right to Constitutional Remedies

C.  Right against Exploitation

D.  Right to Cultural and Educational Rights

✓

Q33 GA
Which of the following is a famous folk dance originating from the
state of Gujarat?

A.  Laavni

B.  Jatra

C.  Yakshgaan

D.  Garba

✓

Q34 GA
A stone is dropped from a certain height. What happens to its
energy just before it reaches the ground?

A.  Potential energy is maximum

B.  Kinetic energy is minimum

C.  Kinetic energy is maximum

D.  Both Kinetic and Potential energies are equal

✓

Q35 GA
Which of the following institutions is responsible for estimating
poverty levels in India using data from surveys, such as the
Household Consumer Expenditure Survey?

A.  Reserve Bank of India

B.  NITI Aayog

C.  National Statistical Office

D.  Ministry of Finance

✓

Q36 GA
Which feature correctly identifies the Konark Sun Temple in Odisha?

A.  Built in Nagara style with dedication to Lord Vishnu

B.  Designed as a chariot with twelve pairs of carved stone
wheels

C.  Constructed in Dravidian style with enclosed temple complex

D.  Built as a rock-cut cave temple dedicated to Shiva

✓

Q37 GA
Which agreement primarily focuses on regulating international
trade in endangered species to prevent their extinction?

A.  Ramsar Convention

B.  CITES

C.  Kyoto Protocol

D.  Montreal Protocol

✓

Q38 GA
The Woods’ Despatch of 1854 is related to which sector?

A.  Railways

B.  Agriculture

C.  Education

D.  Revenue Collection

✓

Q39 GA

Which of the following countries does NOT
border the Caspian Sea?

A.  Turkmenistan

B.  Azerbaijan

C.  Kazakhstan

D.  Armenia

✓

Q40 GA
In March 2025, Senior Women’s National Hockey Championship was
held in which state?

A.  Jharkhand

B.  Haryana

C.  Punjab

D.  Madhya Pradesh
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English

✓

Q41 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(P) with memories as she flashes back
(Q) over a cup of coffee
(R) her expression mellows
(S) to when family members would sit here, nap, read
(T) and catch up with visitors

A.  RSPQT

B.  RQPST

C.  RPQTS

D.  RPSTQ

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

Anything fit to be eaten

A.  Acceptable

B.  Edible

C.  Suitable

D.  Meal

✓

Q43 English
Select the most appropriate idiom that can substitute the underlined segment in the given sentence.

He distributed money to each and every one, irrespective of their caste.

A.  all and sundry

B.  all along

C.  all bets are off

D.  all fingers and thumbs

✓

Q44 English
Select the most appropriate meaning of the underlined idiom.

Ms. Jamia remarked, “We have a huge order to fill by tomorrow morning, so it is all hands on deck until we are finished.”

A.  A call for everyone to help, especially in a difficult situation or emergency

B.  A minor problem or obstacle in a plan or project that can be overcome with relative ease

C.  A similar situation or predicament, facing the same challenges

D.  A desire to move on to new experiences or places
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✓

Q45 English

Read the given passage and answer the questions that follow.

For most of human history, people lived by hunting animals and gathering wild plants. Philosophers often described this life as hard, dangerous
and short because no food was grown or stored, so every day was a struggle to find something to eat. This began to change about 10,000 years
ago, when people in different parts of the world started domesticating plants and animals. The agricultural revolution spread widely, and now
only a few hunter-gatherer groups remain. From the progressivist point of view, it seems obvious why hunter-gatherers shifted to farming —
agriculture produces more food with less effort. Crops provide far more yield per area than wild plants, and domestic animals offer a steady food
source. Imagine a tired group of hunter-gatherers coming across an orchard full of fruit or a field of sheep; they would instantly see the benefits.
Farming promised a more reliable and productive way to get food compared to constant foraging and hunting.

For most of history, how did humans get their food?

A.  By trading goods

B.  By hunting and gathering

C.  By farming crops

D.  By raising animals only

✓

Q46 English
Approximately how many years ago did people begin to domesticate plants and animals?

A.  1,000 years ago

B.  5,000 years ago

C.  10,000 years ago

D.  20,000 years ago

✓

Q47 English
According to the progressivist view, what was the main advantage of agriculture over hunting and gathering?

A.  It required more travel.

B.  It provided more food with less effort.

C.  It preserved wild resources.

D.  It reduced population growth.

✓

Q48 English
Which of the following would be the most suitable title for the passage?

A.  The Disadvantages of Agriculture

B.  Life of Hunter-Gatherers

C.  The Shift from Hunting to Farming

D.  Wild Foods and Their Benefits

✓

Q49 English
What is the central theme of the passage?

A.  The shift from hunting-gathering to agriculture for more reliable food.

B.  The troubled lives of hunter-gatherers.

C.  The convenience of hunting and gathering over farming.

D.  The impact of hunting and gathering on the environment.
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✓

Q50 English
Select the option that can be used as a one-word substitute for the given group of words.

A strategy where misleading but technically true statements are used to deceive

A.  Half-truth

B.  Misdirection

C.  Paltering

D.  Sophistry

✓

Q51 English
Select the wrongly spelt word.

A.  Arrogant

B.  Adjust

C.  Elevator

D.  Bussiness

✓

Q52 English
Complete the following direct sentence.
The principal said, "_________________."

A.  The school is going to conduct extra classes during the next winter break

B.  The school was going to conduct extra classes during the next winter break

C.  The school has been going to conduct extra classes during the next winter break

D.  The school had been going to conducted extra classes during the next winter break

✓

Q53 English
Identify the antonym of the highlighted word.

The stream bifurcated into two narrow winding channels.

A.  Split

B.  Parted

C.  Combined

D.  Divided

✓

Q54 English
Select the most appropriate ANTONYM of the highlighted word.

The students arranged their books in an orderly manner before leaving the classroom.

A.  peaceful

B.  methodical

C.  chaotic

D.  disciplined
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✓

Q55 English
Select the most appropriate option from the given alternatives to fill in the blank.

They ____ for hours before the rescue team found them.

A.  has to wait

B.  were waiting

C.  have waited

D.  had been waiting

✓

Q56 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(O) make sure that Black, Indigenous,
(P) to ensure diverse voices are heard
(Q) all over the world
(R) are represented
(S) Latinos, and people from

A.  OSQRP

B.  ROPQS

C.  OPQSR

D.  PQROS

✓

Q57 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

She is reading _____ book about space travel.

A.  a

B.  an

C.  the

D.  No article required

✓

Q58 English
Select the option that expresses the given sentence in active voice.

High pollution levels in Muzaffarpur were reported by several local news agencies last week.

A.  Several local news agencies report high pollution levels in Muzaffarpur last week.

B.  Several local news agencies have reported high pollution levels in Muzaffarpur last week.

C.  Several local news agencies reported high pollution levels in Muzaffarpur last week.

D.  High pollution levels in Muzaffarpur were being reported by several local news agencies last week.
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✓

Q59 English
Select the most appropriate preposition to fill in the blank.

The success of the project work depends largely _____ actual teamwork and communication.

A.  by

B.  at

C.  on

D.  of

✓

Q60 English
Complete the sentence by choosing correct option.
John is the _________ boy in the class.
3993

A.  idle

B.  idler

C.  idlest

D.  idles

Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ଇଚ୍ଛା ଏବଂ ଉଦ୍ୟମ ଥି ଲେ ସଫଳତା ____ ଜଣଙ୍କ ଜୀବନରେ ଆସି ଥାଏ ।''

A.  ଦୟାରେ

B.  ଧୀରେ ଧୀରେ

C.  ଖୁ ସି ରେ

D.  ବାରମ୍ବାର

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଭାରତର ସଂସଦ ନୂ ତନ ବି ଧି ଗୁ ଡି କକୁ  ଅନୁ ମୋଦି ତ କରନ୍ତି  ।

A.  The Parliament of India passes new laws.

B.  The Parliament of India pass new law.

C.  Parliament India passing the laws.

D.  Parliament of India are passes laws.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Rivers play a vital role in agriculture and transportation.

A.  ନଦୀଗୁ ଡି କ କୃ ଷି  ଏବଂ ପରି ବହନ ନି ମନ୍ତେ ଏକ ଅତ୍ୟାବଶ୍ୟକ ଭୂ ମି କା ନି ର୍ବା ହ କରେ।

B.  ନଦୀମାନେ କୃ ଷି  ପରି ବହନରେ ଭୂ ମି କା ଖେଳନ୍ତି ।

C.  ନଦୀମାନେ କୃ ଷି  ପରି ବହନ ମୁ ଖ୍ୟ ହୋଇଥାଏ।

D.  ନଦୀ କୃ ଷି  ପରି ବହନରେ ଭଲ ଅଛନ୍ତି ।
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✓

Q64 Odia
‘ଗୋବର ଗଣେଶ’ ରୂ ଢି ର ଅର୍ଥ  କ’ଣ?

A.  ଗୋବରରେ ଗଣେଶ ତି ଆରି  କରୁ ଛି

B.  ବାହାରୁ  ଚମକ୍  ଦେଖାଏ କି ନ୍ତୁ ଭି ତରେ କି ଛି  ନାହିଁ

C.  ଗଣେଶ ମୂ ର୍ତ୍ତି ଗୋବରରେ ବୁ ଡ଼ି  ରହି ଛି

D.  ଗୋବର ଖାଇ ଗଣେଶ ପୂ ଜା କରୁ ଛି

✓

Q65 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ତୁ ରଙ୍ଗ

A.  ଧାବକ

B.  ଘୋଡା

C.  ତୀବ୍ର

D.  ତେଜ

✓

Q66 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

ରାଜା ଖାରବେଳ ପ୍ରା ଚୀନ ଓଡ଼ି ଶାର ସବୁ ଠାରୁ  ପ୍ର ସି ଦ୍ଧ ଶାସକ ଏବଂ ମହାମେଘବାହନ ରାଜବଂଶର ଜଣେ ଶ୍ରେ ଷ୍ଠ ରାଜା ଥି ଲେ। ସେ ପ୍ରା ୟ ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ  ପ୍ର ଥମ ଶତାବ୍ଦୀରେ ଭାରତର ପୂ ର୍ବ  ଉପକୂ ଳରେ
ଅବସ୍ଥି ତ ଏକ ପ୍ରା ଚୀନ ଏବଂ ଶକ୍ତି ଶାଳୀ ରାଜ୍ୟ କଳି ଙ୍ଗ ଉପରେ ଶାସନ କରି ଥି ଲେ। ତାଙ୍କ ଜୀବନ ଏବଂ ସଫଳତା ବି ଷୟରେ ସୂ ଚନାର ପ୍ର ମୁ ଖ ଉତ୍ସ ଭୁ ବନେଶ୍ୱର ନି କଟସ୍ଥ ଉଦୟଗି ରି ର ଏକ ଗୁ ମ୍ଫା
କାନ୍ଥରେ ଖୋଦି ତ ହାତୀଗୁ ମ୍ଫା ଶି ଳାଲେଖରୁ  ଆସି ଛି । ପ୍ରା କୃ ତ ଭାଷା ଏବଂ ବ୍ରା ହ୍ମୀ ଲି ପି ରେ ଲି ଖି ତ ଏହି  ଶି ଳାଲେଖରେ , ଖାରବେଳ ଙ୍କ ରାଜତ୍ୱ, ନୀତି , ସାମରି କ ଅଭି ଯାନ ଏବଂ ସଂସ୍କୃତି  ଏବଂ ଧର୍ମ  ପ୍ର ତି
ଅବଦାନର ଏକ ସ୍ପଷ୍ଟ ବର୍ଣ୍ଣ ନା କରାଯାଇଛି  ।

ଖାରବେଳ କଳା, ବି ଜ୍ଞାନ ଏବଂ ସାମରି କ ତାଲି ମରେ ପୁ ଙ୍ଖାନୁ ପୁ ଙ୍ଖ ଶି କ୍ଷା ଗ୍ର ହଣ କରି ବା ପରେ ସିଂ ହାସନ ଆରୋହଣ କରି ଥି ଲେ। ତାଙ୍କ ରାଜତ୍ୱ ସମୃ ଦ୍ଧି , ପ୍ର ଶାସନି କ ଦକ୍ଷତା ଏବଂ ତାଙ୍କ ପ୍ର ଜାଙ୍କ କଲ୍ୟାଣ
ପାଇଁ  ସେ ସଦା ସର୍ବ ଦା ଚର୍ଚ୍ଚା  କରୁ ଥି ଲେ । ପ୍ରା କୃ ତି କ ବି ପର୍ଯ୍ୟ ୟ ସମୟରେ ସେ କ୍ଷତି ଗ୍ର ସ୍ତ ନଗର ପ୍ରା ଚୀର ଏବଂ ସାର୍ବ ଜନୀନ କୋଠା ଗୁ ଡ଼ି କର ମରାମତି  କରି ବା ସହ ବହୁ  ଜନ କଲ୍ୟାଣ କାର୍ଯ୍ୟ  କରି ଥି ଲେ
। ସେ ବାଣି ଜ୍ୟ ଏବଂ କୃ ଷି କୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା ସହ ସଙ୍ଗୀତ, ନୃ ତ୍ୟ ଏବଂ କ୍ରୀ ଡାକୁ  ମଧ୍ୟ ସମର୍ଥ ନ କରୁ ଥି ଲେ | ଏହା କଳି ଙ୍ଗରେ ଆର୍ଥିକ ଏବଂ ସାଂସ୍କୃତି କ ପୁ ନରୁ ଦ୍ଧାରର କାରଣ ପାଲଟି ଥି ଲା।

ସାମରି କ ଦୃ ଷ୍ଟି ରୁ , ଖାରବେଳ ତାଙ୍କର ସଫଳ ଅଭି ଯାନ ପାଇଁ  ଚି ର ସ୍ମରଣୀୟ ରହି ବେ । ସେ ସମ୍ରା ଟ ଅଶୋକଙ୍କ ଠୁ  ପୂ ର୍ବ ରୁ  ମି ଳି ଥି ବା ପରାଜୟ ପରେ କଳି ଙ୍ଗର ହଜି ଯାଇଥି ବା ଗୌରବକୁ  ପୁ ନରୁ ଦ୍ଧାର
କରି ଥି ଲେ । ସେ ଉତ୍ତର ଏବଂ ଦକ୍ଷି ଣ ଭାରତରେ ଅଭି ଯାନର ଏକ ଶୃ ଙ୍ଖଳା ମାଧ୍ୟମରେ ତାଙ୍କର ସାମ୍ରା ଜ୍ୟକୁ  ବି ସ୍ତାର କରି ଥି ଲେ, କଳି ଙ୍ଗର ପ୍ର ଭାବକୁ  ଏହାର ସୀମା ବାହାରକୁ  ବି ସ୍ତାର କରି ଥି ଲେ।
ହାତୀଗୁ ମ୍ଫା ଶି ଳାଲେଖ ଅନୁ ସାରେ, ସେ ଦକ୍ଷି ଣରେ ସାତବାହନମାନଙ୍କୁ  ପରାସ୍ତ କରି ଥି ଲେ ଏବଂ ଉତ୍ତରରେ ମଗଧର ଶକ୍ତି ଶାଳୀ ଶାସକମାନଙ୍କୁ  ମଧ୍ୟ ଚ୍ୟାଲେଞ୍ଜ କରି ଥି ଲେ । ତାଙ୍କ ବି ଜୟ କଳି ଙ୍ଗକୁ
ଧନ ଏବଂ ପ୍ର ତି ଷ୍ଠା ଆଣି ଥି ଲା, ଏହାକୁ  ପ୍ରା ଚୀନ ଭାରତର ଏକ ପ୍ର ମୁ ଖ ରାଜନୈ ତି କ ଶକ୍ତି ରେ ପରି ଣତ କରି ଥି ଲା।

ଖାରବେଳ ଜୈ ନ ଧର୍ମ ର ଜଣେ ମହାନ ପୃ ଷ୍ଠପୋଷକ ମଧ୍ୟ ଥି ଲେ । ସେ ପ୍ରା ଚୀନ ଜୈ ନ ସ୍ମାରକୀଗୁ ଡ଼ି କର ପୁ ନଃନି ର୍ମା ଣ କରି ଥି ଲେ, ଉଦୟଗି ରି  ଏବଂ ଖଣ୍ଡଗି ରି  ପାହାଡ଼ରେ ଭି କ୍ଷୁ  ମାନଙ୍କ ପାଇଁ  ଗୁ ମ୍ଫା
ଖନନ କରି ଥି ଲେ ଏବଂ ଧାର୍ମିକ ସହି ଷ୍ଣୁତାକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ଥି ଲେ । ତାଙ୍କ ଶାସନ କାଳରେ ଜୈ ନ ଧର୍ମ , ହି ନ୍ଦୁ  ଧର୍ମ  ଏବଂ ବୌଦ୍ଧ ଧର୍ମ  ସମେତ ବି ଭି ନ୍ନ ଧର୍ମ  ମଧ୍ୟରେ ସମନ୍ୱ ୟର ପ୍ର ତୀକ ଥି ଲା। ତାଙ୍କ
ଶାସନ କାଳରେ, କଳି ଙ୍ଗ କଳା, ସ୍ଥାପତ୍ୟ ଏବଂ ଆଧ୍ୟାତ୍ମି କତାର କେନ୍ଦ୍ର ଭାବରେ ସମୃ ଦ୍ଧ ହୋଇଥି ଲା।

ରାଜା ଖାରବେଳ କେଉଁ  ରାଜବଂଶର ଥି ଲେ?

A.  ମୌର୍ଯ୍ୟ  ରାଜବଂଶ

B.  ମହାମେଘବାହନ ରାଜବଂଶ

C.  ସାତବାହନ ରାଜବଂଶ

D.  ଗୁ ପ୍ତ ରାଜବଂଶ

✓

Q67 Odia
ଖାରବେଳ ଙ୍କ ରାଜତ୍ୱ ବି ଷୟରେ ସୂ ଚନାର ମୁ ଖ୍ୟ ଉତ୍ସ କଣ ?

A.  ଅଶୋକଙ୍କ ଶି ଳାଲେଖ

B.  ହାତୀଗୁ ମ୍ଫା ଶି ଳାଲେଖ

C.  ଅର୍ଥ ଶାସ୍ତ୍ର

D.  ଇଣ୍ଡି କା
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✓

Q68 Odia
ହାତୀଗୁ ମ୍ଫା ଶି ଳାଲେଖଟି  କେଉଁ ଠି  ଅବସ୍ଥି ତ?

A.  କୋଣାର୍କ

B.  ପୁ ରୀ

C.  ଉଦୟଗି ରି

D.  ରତ୍ନଗି ରି

✓

Q69 Odia
ଖାରବେଳ କେଉଁ  ଧର୍ମ ର ଜଣେ ମହାନ ପୃ ଷ୍ଠପୋଷକ ଥି ଲେ?

A.  ବୌଦ୍ଧ ଧର୍ମ

B.  ଜୈ ନ ଧର୍ମ

C.  ହି ନ୍ଦୁ  ଧର୍ମ

D.  ଖ୍ରୀ ଷ୍ଟି ଆନ ଧର୍ମ

✓

Q70 Odia
ଖାରବେଳ ଙ୍କ ସାମରି କ ଅଭି ଯାନ କେଉଁ  ପ୍ରା ଚୀନ ରାଜ୍ୟର ଗୌରବ ପୁ ନରୁ ଦ୍ଧାର କରି ବାରେ ସାହାଯ୍ୟ କରି ଥି ଲା?

A.  ମଗଧ

B.  ଅବନ୍ତୀ

C.  କଳି ଙ୍ଗ

D.  କୋଶଳ

✓

Q71 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ଭୁ ସ୍ଖଳନ ଯୋଗୁଁ  ପାହାଡି ଆ ସ୍ଥାନକୁ  ଯି ବା ଲାଗି  ବାରଣ କରାଯାଉଛି  |

A.  People are being banned from going to hilly areas.

B.  Due to landslides, people are being banned from going to hilly areas.

C.  Due to heavy rainfall , people are being banned from going to hilly areas.

D.  Due to landslides, people are being banned to come out .

✓

Q72 Odia
"ଚେମଡା" ଶଦ୍ଦର ବି ପରୀତ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  ମସକା

B.  କଠି ନ

C.  ଖରାପ

D.  ଦୃ ଢ
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✓

Q73 Odia
ଯଦି ଓ ସେ ଆସି ବେ, କି ଛି  ଖାଇବେ ନାହିଁ । ଉକ୍ତ ବାକ୍ୟରେ ଅବ୍ୟୟ ପଦଟି କୁ  ଚି ହ୍ନଟ କର ।

A.  ଯଦି ଓ

B.  ଆସି ବେ

C.  କି ଛି

D.  ଖାଇବେ ନାହିଁ

✓

Q74 Odia
ଦୁ ଇ ବା ତତୋଧି କ ବି ଶେଷ୍ୟ ପଦ ମଧ୍ୟରେ ତୁ ଳନା କରି ବା ପାଇଁ  ଯେଉଁ  ବି ଶେଷଣ ପଦ ବ୍ୟବହୃ ତ ହୁ ଏ, ତାକୁ  କ'ଣ କୁ ହାଯାଏ ?

A.  ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

C.  ପରି ମାଣବାଚକ ବି ଶେଷଣ

D.  ତୁ ଳନାତ୍ମକ ବି ଶେଷଣ

✓

Q75 Odia
"ଚି ତା କାଟି ବା"-ଏହି  ରୂ ଢି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ସାହାଯ୍ୟ କରି ବା

B.  ଅନ୍ୟକୁ  ଠକି ବା

C.  ସତ୍ୟ କହି ବା

D.  ଦୁଃ ଖ ପ୍ର କାଶ କରି ବା

Computer

✓

Q76 Computer
Which of the following keyboard shortcuts is used to turn on the pen
tool while presenting a slide show in MS PowerPoint 2019?

A.  Ctrl+P

B.  P

C.  W

D.  B

✓

Q77 Computer
Which of the following is an application of computers in the field
of banking?

A.  Video conferencing

B.  ATM transactions

C.  Graphic designing

D.  Game development

✓

Q78 Computer
In MS Word, which option allows printing specific pages of a
document?

A.  Quick Print

B.  Page Range

C.  Save As

D.  Page Layout

✓

Q79 Computer
How can a user delete a slide from a PowerPoint presentation?

A.  Right-click the slide thumbnail and select “Delete Slide”

B.  Press Ctrl + S

C.  Use File → Save As

D.  Click Home → New Slide
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✓

Q80 Computer
In online culture, using all capital letters is generally understood by
the recipients as the equivalent of __________, which should be
avoided in professional communication.

A.  sending an attachment

B.  whispering

C.  sharing a private joke

D.  shouting or yelling

✓

Q81 Computer
What symbol is utilized to initiate a function in MS Excel?

A.  @

B.  =

C.  #

D.  $

✓

Q82 Computer
Which statement best describes the function of the ALU inside the
CPU?

A.  It stores frequently used instructions.

B.  It performs all arithmetic and logical operations.

C.  It manages the flow of instructions in the CPU.

D.  It handles input and output operations.

✓

Q83 Computer
A file on a computer has the extension .mp3 at the end of its name.
What type of digital content does this file most likely contain?

A.  A text document

B.  An audio file

C.  A photograph

D.  An executable program

✓

Q84 Computer
What is the full form of TELNET (a network protocol)?

A.  Telephone Network

B.  Television Network

C.  Terminal Network

D.  Telecommunications Network

✓

Q85 Computer
Which of the following is considered the first electronic general-
purpose computer?

A.  Mark I

B.  Difference Engine

C.  Abacus

D.  ENIAC

✓

Q86 Computer
The keyboard shortcut Ctrl + X is used for:

A.  Copying Text

B.  Cutting Text

C.  Paste Text

D.  Select Text

✓

Q87 Computer
What does the paintbrush icon next to newly inserted cells in Excel
2019 allow you to do?

A.  Delete the cells

B.  Enter data

C.  Format the inserted cells

D.  Move the cells

✓

Q88 Computer
Which function in MS Excel converts text values to numeric values?

A.  VALUE()

B.  TURN()

C.  FORMAT()

D.  CHANGE()
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✓

Q89 Computer
Which of the following approaches in MS Word 2010 allows you to
generate a new document from an existing template while
preserving the original template's structure, formatting and
placeholders without modifying the template?

A.  Press Ctrl + N to open a blank document, then apply a saved
template using the Design tab manually

B.  Go to the File tab → Click New → Double-click a desired
template from the list → Save the resulting document using Save
As

C.  Locate and open the required .dotx template file directly
from File Explorer, and begin editing it

D.  Use Insert → Object → Text from File, and select a .docx file
that contains template-style formatting

✓

Q90 Computer
Which step is NOT part of saving a .potx template in MS PowerPoint
2021?

A.  Open the File menu and click Save As

B.  Select PowerPoint Template (*.potx) from the 'Save as type'
dropdown

C.  Design and format slides using Slide Master under the View
tab

D.  Insert video clips or background music into individual slides
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Reasoning

✓

Q91 Reasoning
In a certain code language,
'A + B' means ‘A is the wife of B’,
'A – B' means ‘A is the sister of B’,
'A x B' means ‘A is the father of B’,
'A ÷ B' means ‘A is the husband of B’.

How is E related to B if ‘E – R + D x B’?1972

A.  Mother’s sister

B.  Brother's wife

C.  Father's sister

D.  Husband's sister

✓

Q92 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?

KTY GPU CLQ YHM ?

A.  UDI

B.  UIO

C.  UDR

D.  URD

✓

Q93 Reasoning
Each of S, T, U, V, M, N and O has an exam on a different day of a
week starting from Monday and ending on Sunday of the same
week. Only three people have exam between N and T. Only three
people have exam between V and M. O has exam on some day
before T and on some day after S. Only U has exam before M. How
many people have exam after N?

A.  One

B.  Two

C.  Three

D.  Four

✓

Q94 Reasoning
Kundra starts from point A and drives 57 km towards South. He then
takes a left turn, drives 68 km, turns left and drives 63 km. He then
takes a left turn and drives 83 km. He takes a final left turn, drives 6
km and stops at point P. How far (shortest distance) and towards
which direction should he drive in order to reach point A again? (All
turns are 90-degree turns only unless specified)

A.  13 km to the east

B.  14 km to the east

C.  15 km to the east

D.  16 km to the west

✓

Q95 Reasoning
If + means −, − means ×, × means ÷, and ÷ means +, then what will
come in place of the question mark (?) in the following equation?

14 − 7 ÷ 13 + 121 × 11 = ?

A.  100

B.  113

C.  130

D.  155

✓

Q96 Reasoning
TS 10 is related to VU -6 in a certain way. In the same way, ML 14 is
related to ON -2. To which of the following is UP 21 related, following
the same logic?

A.  YT 7

B.  GF 3

C.  WR 5

D.  NJ 7

✓

Q97 Reasoning
Seven people, X, Y, Z, C, D, E and F, are sitting around a circular table
facing the centre of the table. Only four people sit between Z and F
when counted from the right of Z. Z sits third to the left of E. X sits
third to the left of C. Y is an immediate neighbour of both F and E.
How many people sit between D and Y when counted from the right
of D?

A.  Four

B.  Three

C.  Two

D.  One

✓

Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: Some grapes are oranges. All oranges are apples.
Conclusion (I) : Some grapes are apples.
Conclusion (II) : All apples are oranges.

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow
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✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
man out is not based on the number of consonants/vowels or their
position in the letter cluster)5673

A.  RT-UX

B.  PR-SU

C.  HJ-KM

D.  CE-FH

✓

Q100 Reasoning
Refer to the following series and answer the question (All numbers
are single digit numbers only. Counting to be done from left to
right.)
(Left) 2 7 9 8 6 4 5 8 3 5 7 9 6 4 2 3 5 1 8 7 2 6 4 5 3 1 8 7 (Right)
How many such even digits are there each of which is immediately
preceded by an even digit and also immediately followed by an odd
digit?

A.  More than three

B.  One

C.  Two

D.  Three
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